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e | acopie des données de séquence de musique disponibles dans le commerce et/ou de fichiers audio
numeériques est strictement interdite sauf pour usage personnel.
Les copyrights du logiciel et de ce mode d'emploi sont la propriété exclusive de Yamaha Corporation.

e Toute copie du logiciel ou de ce mode d'emploi en tout ou en partie, par quelque moyen que ce soit, est
expressément interdite sans le consentement écrit du fabricant.

e Yamaha n'offre aucune garantie quant a I'usage du logiciel ou de la documentation et ne peut étre tenu
pour responsable des résultats de I'usage de ce mode d'emploi ou du logiciel.

e | es captures d'écran qui illustrent ce mode d'emploi sont proposées a titre indicatif et peuvent étre
légerement différentes de celles qui apparaissent sur votre ordinateur.
Cliquez sur le texte en rouge pour passer a la partie correspondante du manuel.

e L'OMS® et la marque Q@MD" présentés dans ce mode d'emploi sont des marques de fabrique ou des
marques déposées de Opcode Systems, Inc.

e |esnoms des sociétés et des produits cités dans ce mode d'emploi sont des marques de fabrique ou
des marques déposées appartenant a leurs propriétaires respectifs.

Ce mode d'emploi part du principe que vous étes familiarisé a I'environnement Windows ou Macintosh.
Si tel n'est pas le cas, veuillez vous reporter au mode d'emploi de votre logiciel Windows ou Mac OS
avant d'utiliser le Voice Editor.

Pour toute information sur la configuration matérielle requise, les interconnexions entre les
périphériques et l'installation du logiciel Voice Editor, reportez-vous au « Manuel d'installation » et au
mode d'emploi de I'appareil MIDI correspondant.

Les captures d'écran présentées dans ce manuel proviennent principalement de Windows. Les
différences avec la version Macintosh sont clairement indiquées et expliquées.

© 2002 Yamaha Corporation. Tous droits réservés.


A l'attention des lecteurs
Veuillez noter qu'en fonction du système de PC utilisé, il est possible que les illustrations, les couleurs et les polices ne s'affichent pas correctement. Veuillez également noter que les numéros de page des images miniatures peuvent ne pas correspondre à ceux du document.


Qu'est-ce que le Voice Editor ?

Le Voice Editor (Editeur de voix) est une application qui vous permet d'éditer les voix et les effets
de votre générateur de sons via l'ordinateur. Grace a l'interface graphique facile a comprendre,

vous pouvez éditer quasiment tous les parametres de voix du MOTIF-RACK depuis votre

ordinateur — en utilisant la souris pour régler les boutons virtuels, les curseurs et les touches et
en saisissant des valeurs a l'aide du clavier de I'ordinateur. En outre, vous pouvez sauvegarder

sur I'ordinateur toutes les modifications apportées aux voix.
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Démarrage du Voice Editor

Aprés avoir installé le Voice Editor et effectué les connexions requises, suivez les instructions ci-
dessous pour le lancer.

Windows

BITI Pour pouvoir utiliser le Voice Editor avec votre générateur de sons, vous devez installer le pilote MIDI USB
(page 12).

e Démarrage du Voice Editor en tant qu'application autonome

1 Dansle menu [Start] (Démarrer), sélectionnez [Programs] (Programmes) — [YAMAHA OPT
Tools] (Outils YAMAHA OPT) — [Voice Editor for MOTIF-RACK] — [Voice Editor for MOTIF-
RACK].

2 Cliquez sur le bouton [MIDI SETUP] (Configuration MIDI) appelé a I'étape 1 ci-dessus, puis
configurez le port MIDI approprié.

e Démarrage du Voice Editor en tant que logiciel plug-in dans I'application
hote
Vous pouvez utiliser le Plug-in Board Editor en tant que logiciel plug-in dans toute application
hoéte compatible avec I'Open Plug-in Technology (OPT - Technologie de plug-in ouvert). Pour
plus de détails sur I'utilisation du logiciel plug-in, reportez-vous au mode d'emploi de
I'application hote (séquenceur, etc.).

A propos de I'Open Plug-in Technology

L'Open Plug-in Technology (OPT) est un nouveau format de logiciel qui vous permet de
contréler les appareils MIDI a partir d'un logiciel musical. Vous pouvez par exemple démarrer et
faire fonctionner différents éléments de votre systeme musical, tels que les éditeurs de carte
plug-in et les éditeurs de commande de mixage, directement a partir d'un séquenceur
compatible OPT, sans devoir les utiliser séparément. De plus, il n'est plus nécessaire de
configurer les pilotes MIDI pour chaque application, ce qui simplifie votre systéeme de
production de musique et rend les opérations plus simples et plus sdres.

A propos des niveaux OPT
La compatibilité de I'application client avec I'OPT comprend trois niveaux différents, comme
indiqué ci-dessous.

oo, Niveau 1 - L'OPT Panels offre un support de base pour I'ouverture et I'affichage des
)* panneaux de commande OPT qui peuvent transmettre des données via les ports MIDI
PANELs externes des clients. En général, ce niveau permet aux panneaux de commande de
I'éditeur de matériel de base de fonctionner correctement.

@

oeusintees,,  Niveau 2 - L'OPT Processors offre un support aux processeurs MIDI et a I'automatisation
du panneau en temps réel. En général, ce niveau permet aux effets MIDI en temps réel et
PROCESSors NOrs ligne de fonctionner correctement et d'automatiser le fonctionnement d'OPT Panels.

a2

@

qz‘yw’%% Niveau 3 — L'OPT Views offre un support qui vous permet d'éditer les vues et les
°©‘* processeurs/panneaux MIDI qui exigent un accés direct aux structures de stockage du
views  Programme client. En général, ce niveau permet de prendre en charge des vues

d'édition MIDI évoluées.




Implémentation du niveau de I'OPT pour le Voice Editor
Ce tableau montre la compatibilité du Voice Editor avec I'OPT.

Opération du Voice Editor
Niveaux de I'OPT de I'application client
Support des opérations Limites d'utilisation
VIEWS (Niveau 3) !@‘- oui Aucune
PROCESSORS (Niveau 2) {555 1 Ooui Aucune
PROCESSORS
PANELS (Niveau 1) ), oui Réception en bloc

BITI3 1l arrive que certaines opérations ne fonctionnent pas correctement lorsqu'il n'y a pas de fonction
correspondante dans I'application client (séquenceur, etc.). Le niveau d'implémentation le plus haut
de l'application client apparait dans le logo OPT (qui s'affiche en méme temps que les informations
relatives a la version de I'application).

Macintosh

BITLd Sivous utilisez le Voice Editor sur un ordinateur Macintosh, ouvrez « Chooser » dans le menu Apple et

désactivez « AppleTalk ».

Ouvrez le dossier « YAMAHA Tools » et double-cliquez sur l'icbne « VoiceEditorForMOTIF-
RACK » dans le dossier « Voice Editor for MOTIF-RACK ».

Réception des voix présélectionnées

La premiere fois que vous lancez le Voice Editor apres l'installation, la boite de dialogue « Preset
Voice Receive » (Réception de voix présélectionnées) illustrée ci-dessous apparait. Pour pouvoir
éditer les voix présélectionnées et créer ainsi des voix utilisateur, vous devez d'abord charger les
données des voix présélectionnées depuis le MOTIF-RACK.
BITid Sivous n'envisagez pas d'éditer les voix présélectionnées, cette opération n'est pas nécessaire.

PresetYoiceReceive

Preset Yoice data must be lnaded

In order to load Preset Voice data appropriate
poits must be selected.

Press the "Setup” button and select the ports,
then press the "Start” button,

Presefi/oice Receive

Clase
Setup

1. Cliquez sur [Setup] (Configuration) et définissez les ports comme indiqué dans la boite de
dialogue qui s'affiche (page 12).
2. Cliquez sur [Start] (Démarrer) pour commencer a charger les données de voix

présélectionnées.

PresefVoiceReceive

Preset Yoice data must be loaded

In order to load Preset Voice data appropriate
ports must be selected.

Press the "Setup” button and select the ports,
then press the "Start” button

Presetioice Receive

[Efzse:
Seti

3. Une boite de dialogue apparait une fois que I'opération de chargement est terminée.
Cligquez sur [OK] pour continuer.



La boite de dialogue « Preset Voice Receive » n‘apparait pas lorsque l'application est relancée
apres le premier chargement des voix présélectionnées. Si vous cliquez sur [Stop] pendant le
processus de chargement, les données regues jusque la sont considérées comme non valides et
la boite de dialogue « Preset Voice Receive » réapparait la prochaine fois que vous lancez
I'application. De la méme fagon, si vous cliquez sur [Close] (Fermer) avant de charger les
données de voix présélectionnées, la boite de dialogue « Preset Voice Receive » apparait la
prochaine fois que vous lancez 'application.

BT Sivous voulez recharger les données de voix présélectionnées, supprimez le fichier « Preset.ini » du
programme et relancez ensuite le Voice Editor. L'emplacement par défaut du fichier « Preset.ini » est le
suivant :

(Windows) C:\Program Files\YAMAHA\OPT Tools\Voice Editor for MOTIF-RACK\
Module\VEdito\MOTIF-RACK,
(Macintosh) YAMAHA Tools\Voice Editor for MOTIF-RACK\VEditor\MOTIF-RACK.

Barre de menus

La barre de menus contient plusieurs fonctions/commandes d'édition et de configuration.
Cliquez sur le nom de menu désiré pour ouvrir le menu déroulant correspondant et sélectionnez
la fonction/commande que vous souhaitez utiliser. Les fonctions/commandes non disponibles
apparaissent en grisé.

BITid Les menus les plus fréquemment utilisés dans la barre de menus sont également disponibles sous la
forme de boutons dans la barre d'outils du Voice Editor.

File (Fichier)

Windows Macintosh

File Edit & Ii"! Edit MIDI

New Chl+M New EN

DOpen Library...  Chl+0 Open... ¥0

SaweLitan Wi Close  3EW

Save Library As... Capim o

Exit Save As..
Quit EQ

New (Nouveau)
Permet de créer et d'ouvrir un nouveau fichier Bibliothéque.

Open Library... (Ouvrir bibliotheque...) (Open...)
Cette commande est identique a celle du bouton « Open » (Ouvrir) de la barre d'outils (page 10).

Save Library (Enregistrer la bibliothéque) (Save)
Cette commande est identique a celle du bouton « Save » (Enregistrer) de la barre d'outils

(page 11).

Save Library As... (Enregistrer bibliothéque sous...) (Save As...)
Permet d'enregistrer le fichier Bibliotheque sous un nom différent ou nouveau.

Close (Fermer) (Macintosh uniquement)
Permet de fermer la fenétre. Cette fonction est identique a celle de la case « Close » dans la
barre de titre.

Exit (Quitter) (Quit)
Permet de sortir du Voice Editor. Ce menu n'est disponible lorsque le Voice Editor est utilisé en
tant que plug-in de I'application hote.



Edit (Edition)

Windows Macintosh
Edit Setup Iiﬂl MIDI Windo
Copy Ctrl+C Copy *C
Faste [t 5] Pﬂ_S!ZE ) HY
Initialize  Del Initialize
Edit  ChlE Store...
LLitarany E_dlt *®E
Stare., . Library 3L
Irport... Chil+l Import... #I
Compate (Gl Compare #2Z

Copy (Copier)
Copie la voix sélectionnée dans le presse-papiers. Si rien n'est sélectionné, cette commande
apparait en grisé.

Paste (Coller)

Copie la voix depuis le presse-papiers vers le Voice Editor.

Initialize (Initialisation)

Restaure les valeurs par défaut des parameétres de voix sélectionnés. Si rien n'est sélectionné,
cette commande apparait en grisé.

Edit (Edition)
Cette commande est identique a celle du bouton « Edit Window » (Fenétre Edit) de la barre
d'outils (page 15).

Library (Bibliothéque)
Cette commande est identique a celle du bouton « Library Window » (Fenétre Library) de la
barre d'outils (page 17).

Store... (Stocker...)
Cette commande est identique a celle du bouton « Store » de la barre d'outils (page 30).

Import... (Importer)
Cette commande est identique a celle du bouton « Import » de la barre d'outils (page 15).

Compare (Comparer)
Cette commande est identique a celle du bouton « Compare » de la barre d'outils (page 31).



Setup (Configuration) (Windows) /
MIDI (Macintosh)

Windows Macintosh
Setup window Iﬂ":l Windows Help
Setup... Editor Setup...

Tranzmit Bulk... Chil+T
FReceive Bulk... Ctl+R
Honitor

0OMS Port 5etup...
OhdAS MIDI Setup...
0OMS Studio Setup...

Transmit... BT
Receive... #R
Monitor

Setup... (Editor Setup...) (Configuration de I'éditeur...)
Cette commande est identique a celle du bouton « Editor Setup » de la barre d'outils (page 12).

Transmit Bulk... (Envoyer en bloc) (Transmit...)
Cette commande est identique a celle du bouton « Transmit Bulk » de la barre d'outils (page 13).

Receive Bulk... (Recevoir en bloc) (Receive...)
Cette commande est identique a celle du bouton « Receive Bulk » de la barre d'outils (page 14).

Monitor (Ecouter)
Cette commande est identique a celle du bouton « Monitor » de la barre d'outils (page 15).

OMS Port Setup... (Configuration du port OMS...)

(Macintosh uniquement)

Ouvre la fenétre OMS Port Setup du Voice Editor. Reportez-vous a la section « Configuration des
ports OMS » (page 34) pour plus de détails.

OMS MIDI Setup... (Configuration MIDI de I'OMS...)

(Macintosh uniquement)
Ouvre la fenétre OMS MIDI Setup. Reportez-vous a la documentation fournie avec I'OMS pour
plus de détails.

OMS Studio Setup... (Configuration du studio OMS...)

(Macintosh uniquement)

Ouvre la fenétre OMS Studio Setup. Reportez-vous a la documentation fournie avec I'OMS pour
plus de détails.



Fenétre Library (Bibliotheque)

Lorsque vous lancez le Voice Editor, vous voyez d'abord apparaitre la fenétre Library, qui est
constituée d'onglets représentant chacun une mémoire donnée du bloc du générateur de sons.
Chaque onglet reprend la liste des noms, des numéros et des catégories de voix de la mémoire
sélectionnée. Lorsque vous double-cliquez sur le nom d'une voix dans la fenétre Library, la
fenétre Edit (Edition) correspondant a cette voix s'ouvre, ce qui vous permet d'éditer cette
derniere.

BITid Vous pouvez sauvegarder vos réglages en tant que fichier Bibliothéque (*.W6E).
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© Barre d'outils
Cette zone contient les boutons permettant de contréler le Voice Editor (page 10).

@ Onglets
Cliquez sur I'un de ces onglets pour afficher la liste des voix de la banque de voix
correspondante.

© Liste des voix
Cette zone affiche toutes les voix contenues dans la mémoire sélectionnée sous la forme
d'une liste déroulante. Vous y trouverez le nom, le numéro et la catégorie de chaque voix.
Pour réarranger les voix, il vous suffit de faire glisser leurs numéros jusqu'a un nouvel
emplacement et de les y déposer. Vous pouvez également renommer une voix dans
Windows. Pour ce faire, sélectionnez le nom de la voix en question, puis cliquez de nouveau
dessus et saisissez un nouveau nom. Sur un Macintosh, vous devez cliquer sur le nom de la
voix tout en maintenant la touche [Control] enfoncée, puis choisir « Edit Voice Name » (Editer
le nom de la voix) dans le menu déroulant et taper le nouveau nom dans la boite de dialogue.

BT Pour sélectionner plusieurs voix en méme temps, cliquez sur le numéro de la premiére voix, maintenez
la touche [Shift] enfoncée et cliquez sur le numéro de la derniere.

BT Les noms de voix peuvent comporter jusqu'a 10 caractéres.



Barre de fractionnement (Windows uniquement)

Si vous positionnez le pointeur de la souris sur la ligne (barre de fractionnement) qui sépare
la section Track Parameter (Parametres de piste) de la section Block (Bloc), le pointeur se
transforme en oultil de fractionnement. Cet outil vous permet de faire glisser la barre de
fractionnement et de modifier la largeur des deux sections.

BITid Vous pouvez modifier la taille de n'importe quelle fenétre en placant le pointeur de la souris sur I'un des
bords (supérieur, inférieur, gauche ou droit) et en faisant glisser celui-ci jusqu'a ce que la fenétre
atteigne les dimensions souhaitées.

Affichage des noms de voix uniquement (Windows uniquement)
Vous pouvez vous contenter d'afficher les noms de voix de la mémoire sans que leur numéro
et leur catégorie n'‘apparaissent. Pour ce faire, cliquez avec le bouton droit de la souris a
n'importe quel endroit de la liste de voix et sélectionnez « List » (Liste). Cela peut s'avérer
utile pour sélectionner des voix rapidement, puisque la liste déroulante s'en trouve
raccourcie.
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BITid Pour revenir a I'affichage de la liste compléte des noms, numéros et catégories de voix, cliquez avec le
bouton droit de la souris sur n'importe quelle partie de la liste et sélectionnez « Details » (Détails).
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Barre d'outils de la fenétre Library
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© Bouton « Open » (Ouvrir)
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Ouvrir » et sélectionner le fichier

Bibliothéque a ouvrir.

Boite de dialogue « Ouvrir »
Sélectionnez le fichier Bibliothéque de votre choix (extension .W6E) et cliquez sur [Open]. Le
contenu du fichier sélectionné apparait dans la fenétre Library.

2|
@_| Bechercher dans : |a Libirary j|" I‘j‘ E-
I _@ Myhoice. whe
@

®

@ Nomdsfitier: | e |

@— Lipe: [MOTIF-RACK Librery File [* WEE) j|| Arruler | ®

BT Sivous utilisez un ordinateur Macintosh, la boite de dialogue « Open » traditionnelle s'affiche.

(1) Regarder dans : ....Cliquez sur cette zone et sélectionnez le dossier contenant les
fichiers Voice Editor.

(2 Zone delliste........... Affiche le contenu du dossier actuellement sélectionné.
(3) Nom de fichier : ....Affiche le nom des fichiers sélectionnés dans la liste.
@ Type ..o, Cliquez sur cette case pour sélectionner le type de fichier. Si vous

sélectionnez *.W6E, les fichiers Bibliotheque du MOTIF-RACK
s'affichent. Si vous sélectionnez *.W2E, ce sont les fichiers
Bibliotheque du MOTIF6/MOTIF7/MOTIF8 qui s'affichent.

BITi Si vous sélectionnez un fichier « *W2E », le Plugin 3 (données plug-in) du fichier Bibliothéque
sélectionné ne s'ouvre pas.

BT Vous pouvez sélectionner et ouvrir des fichiers Bibliotheque du MOTIF6/MOTIF7/MOTIFS. Le son
obtenu risque toutefois d'étre différent de celui de I'instrument original.

(5) Bouton [Ouvrir] .....Cliquez sur ce bouton pour ouvrir le fichier sélectionné dans la liste.
(6) Bouton [Annuler] ..Cliquez sur ce bouton pour annuler I'opération.

1)



@ Bouton « Save » (Enregistrer)
Cliquez sur ce bouton pour enregistrer le fichier Bibliothéque existant contenant vos
nouveaux réglages. Si vous travaillez sur un nouveau fichier, ce bouton vous permet d'ouvrir
la boite de dialogue « Enregistrer sous », dans laquelle vous pouvez nommer et enregistrer
vos réglages en tant que nouveau fichier Bibliotheque (*.W6E).

Boite de dialogue « Enregistrer sous »

BITiA Les noms des fichiers Bibliothéque peuvent comporter 8 caractéres maximum, plus une extension de
3 caracteres.

Enregiztrer zous ﬂﬁl
®_' Enregistrer dans : |E Library jl# £% B3
jra ryoice. whe
@—
@—' Nom de fichier ; [Myvaice? wie ||| Erregistrer I |»—@
@—| Tvpe: | MOTIF-RACK. Library File [*'w/EE) jl | Anruler U ®
s

BIT1E Sivous utilisez un Macintosh, la boite de dialogue « Save As » traditionnelle s'affiche.

(1) Enregistrer dans : Cliquez sur cette case pour choisir le dossier dans lequel vous
souhaitez enregistrer le fichier Bibliotheque.

(2) Zone delliste .......... Affiche le contenu du dossier dans lequel vous souhaitez enregistrer
le fichier.
(3) Nom de fichier :.....Précisez le nom du fichier Bibliothéque a sauvegarder.
@ Type: ... Cliguez sur cette case pour sélectionner le type de fichier.
(5) Bouton
[Enregistrer] .......... Cliquez sur ce bouton pour enregistrer le fichier Bibliothéque sous le

nom spécifié dans le champ « Nom de fichier ».

(6) Bouton [Annuler] ..Cliquez sur ce bouton pour quitter la boite de dialogue sans
enregistrer le fichier.

BITi3 Sivous sauvegardez un fichier sur un ordinateur Macintosh, I'extension « .W6E » n'est pas ajoutée
automatiquement.



©® Bouton « Editor Setup »
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Setup » et effectuer les réglages du
port de sortie MIDI.

Boite de dialogue « Setup »

C'est dans cette boite de dialogue que vous devez configurer le Voice Editor de maniere a
pouvoir recevoir/transmettre des données de voix vers/depuis votre générateur de sons.
Cliquez sur le bouton [OK] pour appliquer les réglages et quitter la boite de dialogue et sur
[Cancel] pour fermer la boite de dialogue sans appliquer les réglages.

Windows Macintosh
x| =———Setup
O IMIDIIn Fo . [SREYIEEYE]
@_]M.D.mpmt o Uss o0t o1 ]| |"""D' L KRN |__®
g ] [pevicens: S |- —®
O[T \
(\@ |Dump Interval: |—— 5)
(6)—— Emantotost: [bay e =] ok | [cancer |
I [ o ] Cancel
(1) MIDI In Port :
(Port MIDI In).......... Cliquez sur cette case et sélectionnez le port MIDI In. Vous pouvez

utiliser le Voice Editor pour recevoir des données envoyées par
I'appareil connecté a ce port.
(2) MIDI Out Port :
(Port MIDI Out)....... Cliquez sur cette case et sélectionnez le port MIDI Out. Vous pouvez
utiliser le Voice Editor pour contréler et éditer I'appareil connecté a ce
port.

BITi Sivous utilisez un Macintosh, le réglage du port MIDI Out se fait dans la fenétre OMS Port Setup.
Pour plus de détails, reportez-vous a la section « Réglages OMS » (page 33).

(3 MIDI Ch :

(Canal MIDI) ........... Cliquez sur cette case pour sélectionner le canal MIDI Out. Cette
fonction est utilisée lorsque le son est contrélé a 'aide du clavier
apparaissant a I'écran dans les fenétres Edit.

() Device No.:

(N° de I'appareil)....Cliquez sur cette case pour sélectionner le numéro de l'appareil MIDI
de votre générateur de sons.
(5) Dump Interval : (Intervalle
de vidage) .............. Cliquez sur cette case pour déterminer l'intervalle entre les vidages
MIDI successifs.
BITA Sil'intervalle défini est trop court, des erreurs peuvent surgir lors de la transmission de données MIDI.
(6) Export to Host : (Exporter
vers I'héte)............. Cliquez sur cette case pour sélectionner les données a exporter vers
le SQO1 (lorsque le SQO1 est utilisé comme application client). Si vous
sélectionnez « Library data » (Données de la bibliotheque), toutes les
données de voix éditées dans le Voice Editor sont stockées dans le
fichier de morceau (*.yws) lorsque vous sauvegardez ce dernier sur
le SQO1. Si vous sélectionnez « None » (Aucune), vous ne pouvez
exporter aucune donnée du Voice Editor dans I'application client.

BITi Lorsque vous ouvrez le morceau contenant les données du fichier Bibliotheéque dans le SQO01, les
données de voix exportées sont ouvertes en méme temps que le Voice Editor.

BITi 1l est possible que cette opération ne soit pas disponible, selon I'application client que vous utilisez.
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O Bouton « Transmit » (Envoyer)
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Transmit » qui vous permet de
transférer tous les réglages vers le générateur de sons.

Boite de dialogue « Transmit »
Vous pouvez envoyer les données de voix en bloc a votre générateur de sons. Appuyez sur
le bouton [Start] (Démarrer) pour commencer la transmission des données. La barre de
progression vous indique le volume de données déja transmis. Pour terminer, cliquez sur le
bouton [Close] pour fermer la boite de dialogue.
Transmit Dialog E
@ %L.;r;smit INDrmaI Jzer 1 j
Tranzrmit
o—=d
®
Cloze @
(1) Transmit Type
(Type d'envoi) .................. Détermine les données de voix a envoyer.
Normal User 1......ccccoooeviinnn. Toutes les voix utilisateur 1 normales
Normal User 2.........cccccvvennne. Toutes les voix utilisateur 2 normales
User Normal 1+2 ... Toutes les voix utilisateur normales
DrumUser........ccooeiiiiii. Toutes les voix de batterie utilisateur
Normal User 1+2 + Drum...... Toutes les voix utilisateur normales et les voix de batterie utilisateur
Plug-in 1 User .....ccccooveviennnn. Toutes les voix utilisateur plug-in 1
Plug-in 2 User ......ccccooeveennnn. Toutes les voix utilisateur plug-in 2
Plug-in 1+2 User.................... Toutes les voix utilisateur plug-in
Al Toutes les voix utilisateur (normales, de batterie et plug-in)
(2) Barre de progression ...... Vous indique le volume de données déja transmis.
(3 Bouton [Start] ................. Cliquez sur ce bouton pour transmettre les données.
(@) Bouton [Close]................. Cliquez sur ce bouton pour fermer la boite de dialogue.
BITid Le numéro de I'appareil MIDI doit étre paramétré correctement de maniére a permettre I'envoi de blocs
de données. Pour plus de détails, reportez-vous a la page 12.




© Bouton « Receive » (Recevoir)
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Receive » et recevoir ainsi tous les

réglages de votre générateur de sons.

Boite de dialogue « Receive »
Les données de voix peuvent étre regues en bloc depuis votre générateur de sons.
Sélectionnez les blocs de données de voix que vous souhaitez recevoir, puis cliquez sur le
bouton [Start]. La barre de progression indique le volume de données déja recu. Pour
terminer, cliquez sur le bouton [Close] pour fermer la boite de dialogue.
Receive Dialog E
@ ?:;:WE INormaI dzer 1 j
Receive
@ |
®
Cloze @
(1) « Receive Type »
(Type de réception) ........ Cliquez sur ce bouton pour sélectionner les données de voix
(internes/externes/toutes) a recevoir.
Normal User 1......ccccoooeviinnn. Toutes les voix utilisateur 1 normales
Normal User 2.........ccocveennne. Toutes les voix utilisateur 2 normales
User Normal 142 ... Toutes les voix utilisateur normales
DrumUser.......cccoooeiiiiii. Toutes les voix de batterie utilisateur
Normal User 1+2 + Drum ...... Toutes les voix utilisateur normales et les voix de batterie utilisateur
Plug-in 1 User .....cccccooveveennnn. Toutes les voix utilisateur plug-in 1
Plug-in 2 User ......cccccooeveennn. Toutes les voix utilisateur plug-in 2
Plug-in 1+2 User.................... Toutes les voix utilisateur plug-in
Al Toutes les voix utilisateur (normales, de batterie et plug-in)
(2) Barre de progression ...... Indique le volume de données déja recu.
(3) Bouton [Start] ................ Cliguez sur ce bouton pour recevoir les données.
(@) Bouton [Close]................. Cliquez sur ce bouton pour fermer la boite de dialogue.
BT Le numéro de l'appareil MIDI doit étre paramétré correctement pour pouvoir recevoir des blocs de
données. Pour plus de détails, reportez-vous a la page 12.




O Bouton « Edit Window » (Fenétre d'édition)
Cliguez sur ce bouton pour ouvrir la fenétre Edit (courante) correspondant a la voix
sélectionnée dans la liste. Pour plus de détails, reportez-vous a la page 17.

© Bouton « Monitor »
Lorsque vous cliquez sur ce bouton, les données de voix sont envoyées en bloc a votre
générateur de sons pour contréle chaque fois que vous sélectionnez une voix. Cliquez de
nouveau dessus pour désactiver cette fonction.

BT Pour controler la voix, vous devez utiliser le clavier connecté a votre générateur de sons.

© Bouton « Import » (Importer)
Cliguez sur ce bouton pour ouvrir la boite de dialogue « Import » et importer des voix
provenant d'un fichier Bibliotheque existant. Vous pouvez utiliser la fonction glisser-déposer
pour déplacer les voix en question dans la fenétre Library.

Boite de dialogue « Import »

BT 1l est possible d'ouvrir plusieurs boites de dialogue en méme temps.

File: ; i _
= = — @
FEIEC Y ' == | ,
] | File Name: IVoice.wEe | || fipen Fie | l e ©)
Normal User 1 iNormaI Uger 2 i | Normal Freset 2 | Noma * ] * )
Voice Name | M. | hemary: |UserNormaI1 jl = 3
Init Y oice ao1
:n!tﬁo!ce ggg Mo, | Vaice Mame |
nit Voice 001 | Brites 700 -
It W oic: an4
—— anz 0ld Blues
Ihit Y gice wlila]
Init Voice I O03 | S700E0IdEp
L T S FO0%D
Irit Voice e i P @
Ihit Y cice aos
——— ang Dream
Init Woice an3
s on? T arnorow
Init Yoice a0 :
Init Vaice 011 005 | PiancdPed
e ons CPa0sER
Init Yoice oz .
s mo Yama EP's
Init Vaoice m3i ik Mr Klank
Ipit Vaice 014 L t-an
Init Y oice 15 (5
Init Yaice BB P
Init ¥ oics ik, Close | ®
Init Y oice a1a
Init Y oice s -
Init Woice 020
Init Voics 021 - =l
(1) FileName :............. Indigue le nom du fichier Bibliotheque a partir duquel vous allez

importer des données de voix.
(2) Bouton [Open File]

(Ouvrir fichier)....... Cliquez sur ce bouton pour ouvrir la boite de dialogue « Open File » et
sélectionner le fichier Bibliotheque a ouvrir.

(3) Memory :

(Mémoire)............... Cliquez sur ce bouton pour choisir la banque de mémoire a partir de
laguelle vous importerez les données de voix.

©




(@) Liste de voix.......... Cette zone affiche toutes les voix contenues dans la mémoire
sélectionnée sous la forme d'une liste déroulante, par numéro de
voix. Vous pouvez y sélectionner une voix et I'importer directement
dans la liste de voix de la fenétre Library a l'aide de la fonction
glisser-déposer. (Vous pouvez également importer plusieurs voix de
cette facon.) Dans Windows, vous pouvez par ailleurs copier une
voix. Pour ce faire, sélectionnez-la, puis appuyez sur les touches
[Ctrl]+[C] du clavier de I'ordinateur. Basculez ensuite vers la fenétre
Library et appuyez sur [Ctrl]+[V] a I'endroit ou vous voulez la coller
(importer).

BITid La voix sélectionnée ne peut pas étre importée dans la liste située sous I'onglet Preset Voice (Voix
présélectionnée).

BT Pour sélectionner un bloc de voix, cliquez sur le numéro de la premiére voix, maintenez la touche
[Shift] enfoncée et cliquez sur la derniere.

BITid Une voix normale ne peut pas étre importée dans une voix de batterie ou une voix plug-in. De
méme, une voix de batterie ne peut étre importée dans une voix normale ou plug-in.

BITid Des voix présélectionnées de la carte plug-in peut étre importées depuis le dossier « Data »
(Données). Par défaut, vous pouvez trouver ce dossier dans le dossier suivant.
(Windows) C:\Program Files\YAMAHA\OPT Tools\Voice Editor\Voice Editor for MOTIF-RACK\Library
(Macintosh) YAMAHA Tools\Voice Editor for MOTIF-RACK\Library

(5 Monitor ................ Si vous cochez cette case, les blocs de données de chacune des
voix sélectionnées dans la liste seront transférées vers votre
générateur de sons pour y étre contrélées. Pour contrbler la voix,
utilisez le clavier connecté a votre générateur de sons.

BT Le controle n'est possible que si le port MIDI Out et les autres parameétres de configuration de
I'éditeur sont correctement définis. Pour plus de détails, reportez-vous a la page 12.

(6) Bouton [Close]....... Cliquez sur ce bouton pour fermer la boite de dialogue Import.




Fenétre Edit

Le Voice Editor vous permet d'éditer trois types de voix : les voix normales, les voix de batterie et
les voix plug-in. Dans la fenétre Library, cliquez sur I'onglet contenant la voix normale/de batterie/
plug-in que vous souhaitez éditer. Double-cliquez ensuite sur la voix (ou sélectionnez-la et
cliquez sur le bouton « Edit Window ») pour ouvrir la fenétre Edit.

* |esréglages effectués dans la fenétre Edit sont transférés en temps réel via MIDI depuis
votre ordinateur vers le générateur de sons.

e Lesréglages de la fenétre Edit peuvent étre stockés dans un fichier Bibliotheque.

e Pour plus de détails sur les différents paramétres, reportez-vous au mode d'emploi du
MOTIF-RACK et a la liste de données.

Fenétre Voice Edit (Edition de voix)

Lorsque vous éditez une voix, I'écran suivant apparait :

Bouton Editor Setup
Bouton Library Window

Bouton Store (2] o 6 (6]

Bouton Compare

EIEFIED

’7 p AUDITION PHRASE

e " W SUSTAIN FELEASE
FILTER | ¢ v f’J f’J \
: RELEASE DEPTH  CUTOFF

(]

®
_______________________________ ®

© Barre d'outils
Celle-ci contient des boutons permettant d'exécuter différentes fonctions de base dans le
programme. Les quatre boutons suivants sont disponibles :

e Bouton Editor Setup.............cco....... Voir page 12.
® Bouton Library Window

(Fenétre Library) .....ccccooviiiviinnnn Cliquez sur ce bouton pour faire réapparaitre la fenétre Library.
® Bouton Store ......oocevviiiiiii Cliguez sur ce bouton pour ouvrir la boite de dialogue

« Store » dans laguelle vous pouvez attribuer un nom a votre
voix apres l'avoir éditée et sélectionner I'endroit ou la stocker.

e Bouton Compare............cccoceeveennn. Lorsque vous cliquez sur ce bouton, les blocs de données de
la voix d'origine (avant édition) sont envoyés a l'instrument
connecté. Cliquez de nouveau dessus pour envoyer les blocs
de données relatifs a la voix éditée. Ce bouton permet alors
d'effectuer des comparaisons A/B entre la voix d'origine et la
voix éditée.



© Panneau VOICE
Ce panneau affiche le nom, la catégorie d'instrument et la phrase auditionnée de la voix. Vous
pouvez également renommer la voix éditée et modifier la catégorie instrumentale et la phrase
auditionnée depuis le menu déroulant.

PITd Les noms de voix peuvent comporter jusqu'a 10 caractéres.

© Panneau COMMON EDIT (Edition rapide)
Ce panneau vous permet de modifier rapidement le volume et les caractéristiques sonores de
la voix en changeant les parametres de I'amplitude et du filtre.

BITIA Les parametres disponibles pour I'édition différent en fonction de la voix sélectionnée (normale,
batterie ou plug-in). Ces parametres apparaissent sous forme de boutons virtuels dans la fenétre.

Utilisation des boutons de parameétres

Vous pouvez modifier le réglage des boutons de paramétres. Pour cela, cliquez avec le
bouton droit de la souris sur I'un des boutons et sélectionnez « Rotate » (Pivoter) ou « Up/
down or left/right » (Haut/bas ou gauche/droite).

Lorsque vous sélectionnez « Rotate », vous pouvez modifier les valeurs des paramétres (des
« boutons » du panneau) par une rotation de la souris.

Lorsque vous sélectionnez « Up/down or left/right », vous pouvez modifier les valeurs des
parameétres (des « boutons » du panneau) en déplacant la souris verticalement ou
horizontalement.

BITIE Le réglage effectué ici affecte tous les boutons.

O Réglages PITCH BEND (Variation de ton)
Utilisez le bouton « LOWER » (Inférieur) pour déterminer le point le plus bas de la plage de la
molette de variation de ton et le bouton « UPPER » (Supérieur) pour définir le point le plus
haut.

© Bloc PORTAMENTO
Utilisez le sélecteur pour activer/désactiver la fonction portamento et le bouton « TIME »
(Temps) pour spécifier la durée de portamento. Cliquez sur la zone de texte et sélectionnez le
mode portamento.
Le bloc « PORTAMENTO » n'est pas disponible pour les voix de batterie.

O Bloc ARPEGGIO
Utilisez le sélecteur pour activer/désactiver les arpeges et le bouton « TEMPO » pour
spécifier la vitesse de I'arpégiateur. Cliquez sur la zone de texte située sous le sélecteur pour
sélectionner le mode arpége.
Cliguez sur la zone de texte située a gauche du sélecteur pour sélectionner le type
d'arpéges. Vous trouverez les parametres propres aux arpéges dans la boite de dialogue
« ARPEGGIO » qui s'ouvre lorsque vous cliquez sur le bouton [DETAIL].

@ Bouton [CTRL SET/COM LFO] (Jeu de commandes/OBF courant)
Cliguez sur ce bouton pour ouvrir la boite de dialogue « CONTROLLER SET /COMMON
LFO ». Dans le panneau supérieur, vous pouvez définir les paramétres de tous les contréleurs
tels que les molettes de modulation et de variation de ton. Le panneau inférieur vous permet
de spécifier les parametres de I'OBF courant.
Le panneau « COMMON LFO » n'est disponible que pour les voix normales.

©



Boite de dialogue « CONTROLLER SET/COMMON LFO »
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Panneau CONTROLLER SET

Vous pouvez affecter les contréleurs de votre synthétiseur (par exemple, la molette de
modulation ou la modification ultérieure du clavier) a divers paramétres de maniére a pouvoir
modifier ces derniers en temps réel. Par exemple, vous pouvez assigner la molette de
modulation au parametre de résonance du filtre lorsque la voix normale est sélectionnée. Au
total, vous pouvez affecter jusqu'a six contréleurs.

(1)SOURCE........................... Sélectionnez I'un des contrdleurs suivants : « FS » (commande
au pied), « FC1 » (contrbleur au pied 1), « FC2 » (contrbleur au
pied 2), « BC » (commande du souffle), « AT » (modification
ultérieure), « PB » (molette de variation de ton), « MW »
(molette de modulation) ou « AS1/2 » (bouton attribuable 1/2).

(2) Réglages DEPTH

(Profondeur) ................... Détermine dans quelle mesure le contréleur sélectionné affecte
le paramétre qui lui est assigné.

(3) Réglages DESTINATION. Cliquez sur la zone de texte pour sélectionner le paramétre
que vous souhaitez controler.

(@) Sélecteurs ELEMENT......Cliquez sur ces sélecteurs pour activer/désactiver les éléments
concernés par l'affectation des contréleurs.

Panneau COMMON LFO (voix normale uniquement)
(5) Réglage LFO WAVE

(Onde d'OBF)................... Cliquez sur la zone de texte pour sélectionner la forme d'onde
de I'OBF.
(6) Réglage LFO SPEED
(Vitesse de I'OBF) ........... Cliquez sur la zone de texte pour sélectionner la vitesse de
I'OBF.
(7) Réglage LFO PHASE
(Phase de I'OBF) ............. Cliquez sur la zone de texte pour sélectionner la phase de
I'OBF.
Réglage [LFO KEY ON RESET] (Réinitialisation de I'OBF avec
activation de touche).......... Cliquez sur la zone texte pour sélectionner la méthode de

redémarrage de I'OBF lorsqu'une note est jouée.

©




(9) Réglage TEMPO SYNC (Synchronisation

dutempo) ... Cliquez sur la zone de texte pour activer/désactiver TEMPO SYNC.
Réglage TEMPO SPEED
(Vitesse du tempo).......... Cliquez sur la zone de texte pour déterminer la maniere dont

I'OBF est synchronisé avec I'arpege ou le séquenceur.
11 Réglage DEPTH
(Profondeur) .................... Détermine dans quelle mesure le contrdleur sélectionné affecte
le paramétre qui lui est assigné.

12 Réglages DESTINATION. Cliquez sur la zone de texte pour sélectionner le paramétre
que vous souhaitez contréler.

13 Sélecteurs ELEMENT...... Cliquez sur ces sélecteurs pour activer/désactiver les éléments
concernés par l'affectation des contréleurs.

Graphique de I'éditeur ... Cliquez et faites glisser les « poignées » (repéres carrés) pour
déterminer le comportement de I'OBF courant en fonction du
temps. La premiére poignée (a I'extréme gauche) commande
le parametre « LFO Delay Time » (Temps de retard de I'OBF),
la deuxieme le paramétre « LFO Fade In Time » (Temps
d'ouverture par fondu sonore de I'OBF), la troisieme le
parameétre « LFO Control Time » (Durée de contrdle de I'OBF)
et la derniere (a I'extréme droite) le parameétre « LFO Fade Out
Time » (Temps de fermeture par fondu sonore de I'OBF). Faites
glisser les poignées horizontalement pour régler les temps de
transition.

(15 Bouton USER LFO
(OBF utilisateur).............. Cliquez sur ce bouton pour ouvrir la boite de dialogue USER LFO.

Panneau User LFO (voix normale uniquement)

Y
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USER LFO
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(1) TOTAL STEP

(Total des étapes)..Détermine le nombre d'étapes de I'onde de I'OBF en cours d'édition,
avec un maximum de seize.

(2) SLOPE (Pente)....... Détermine les caractéristiques de pente ou de rampe de I'onde de

I'OBF.
e OFF ..o Pas de pente ; I'OBF atteint directement le niveau de chaque étape.
eUP . ... L'OBF passe a I'étape suivante lorsque la valeur de celle-ci est
supérieure. Pas de pente pour les étapes inférieures.
¢ DOWN............. L'OBF passe a I'étape suivante lorsque la valeur de celle-ci est inférieure.

Pas de pente pour les étapes supérieures.
e UP & DOWN.....L'OBF passe au niveau supérieur ou inférieur pour atteindre le niveau de
chaque étape.

©




(3) TEMPLATE

(Modele) ................. Vous pouvez sélectionner un modeéle préprogrammé d'onde d'OBF.
Le graphique de I'onde du modéle sélectionné apparait dans la boite
de dialogue.

e random (aléatoire)............ Définit des valeurs d'étapes au hasard, en créant a chaque
fois une onde d'OBF aléatoire différente.

e alll....oooiiiiiiii Les valeurs de toutes les étapes sont paramétrées sur O.
e all6d....ccoiiiiii Les valeurs de toutes les étapes sont paramétrées sur 64.
© all127 i Les valeurs de toutes les étapes sont paramétrées sur 127.
e saw up (dent de scie

vers le haut)..................... Crée une onde en dent de scie vers le haut.
e saw down (dent de scie

versle bas)........oooccoe, Crée une onde en dent de scie vers le bas.

® even step (étape paire)....Les valeurs de toutes les étapes paires sont paramétrées sur
127 et les valeurs des étapes impaires sur 0.

e odd step (étape impaire) .Les valeurs de toutes les étapes impaires sont paramétrées
sur 127 et les valeurs des étapes paires sur 0.

(@) Graphique de I'onde .....Cliquez sur la zone de texte et sélectionnez la méthode de
redémarrage de I'OBF lorsqu'une note est jouée.

(5) RESET (Réinitialiser) .... Les valeurs de toutes les étapes sont réinitialisées sur 0.
(6) VALUE (Valeur).............. Editez la valeur de chaque étape en vous servant du bouton

correspondant.

CONTROLLER (voix plug-in uniguement)

Celui-ci détermine la profondeur de la hauteur de ton, de la coupure, de la modulation de la
hauteur de ton, de la modulation de la coupure et de la modulation de I'amplitude.

© Section ELEMENT
Cette section est expliquée plus en détail dans la partie « Section Element » (page 23).

© Sections INSERTION EFFECT (Effet d'insertion)
Cette section est expliquée plus en détail dans la partie « Effet d'insertion » (page 28).

@ Réglages SYSTEM EFFECT (Effet systéme)
Cette section est expliquée plus en détail dans la partie « Effets systeme » (page 28).

® Clavier
Cliquez sur n'importe quelle touche du clavier pour contréler la voix éditée a I'aide de cette
touche.

@ Réglages KEY ASSIGN (Affectation de touche)
Cliquez sur la zone de texte de gauche pour sélectionner un réglage Key Assign. Cliquez sur
la zone texte de droite pour sélectionner Monophonic ou Polyphonic. Les réglages « KEY
ASSIGN » ne sont pas disponibles pour les voix de batterie.

® Réglages MICRO TUNE (Accord micro)
Cliquez sur la zone de texte pour sélectionner un réglage d'accord micro préprogrammé.
Les réglages « MICRO TUNE » ne sont pas disponibles pour les voix de batterie.

@ Réglages ASSIGNABLE 1/2 (Attribuable1/2)
Utilisez les boutons pour régler la valeur du parametre affecté a chacun des contréleurs
attribuables 1/2.

® Réglages MEQ GAIN CONTROL (Commande de gain de I'égaliseur principal)
Utilisez ces boutons pour régler le gain de chaque bande de fréquence de I'égaliseur a cing

bandes.



Section ELEMENT

© Boutons EL (Elément) 124
Cliquez sur ces boutons pour ouvrir les boites de dialogue « ELEMENT » correspondantes.

BITI3 Pour les voix de batterie, le panneau suivant s'affiche. Cliquez sur [KEY CO...C6] pour ouvrir la boite de
dialogue « Drum Key » (Touche de batterie) (page 26).

ELEMEHT

BITId Pour les voix plug-in, le panneau suivant s'affiche. Cliquez sur [DETAIL] pour ouvrir la boite de dialogue
« Plug-in Voice Detail » (Détail de la voix plug-in).

(1) VOICE BANK (Banque de voix).......... Détermine la banque de voix plug-in.
(2) VOICE NUMBER (Numéro de voix) .... Détermine le numéro de la voix plug-in.
(3)LFO (OBF)....cooiiiiiiiii, Détermine la vitesse de I'OBF, la modulation de hauteur de

ton et le retard.

(4) NOTE SHIFT (Décalage de notes)...... Détermine l'importance du décalage des notes
(transposition des touches).

Cliquez sur [NATIVE PARAM] (Parameétre natif) pour ouvrir la bolte de dialogue « NATIVE Parameter ».
Sélectionnez la carte plug-in a éditer dans le coin supérieur gauche de l'illustration du clavier qui
apparait dans la fenétre.

™ PLG150-AN
PLG150-D

PLG150-PF
PLGTEO-WL
PLG150-DR.
PLGIG0-PC

@ Sélecteurs ON/OFF
Cliquez sur ces sélecteurs pour activer/désactiver chaque élément.

© Boutons de niveau des éléments
Utilisez ces boutons pour régler le niveau de chaque élément.

O Sélecteurs EF (Effet) 1/EF (Effet) 2/ THRU
Cliquez sur ces sélecteurs pour assigner chaque élément a I'effet d'insertion 1 ou 2 ou pour
passer outre les sections d'effets d'insertion.
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© LFO WAVE (Onde d'OBF)
Cliguez sur la zone de texte « WAVE » et sélectionnez la forme d'onde de I'OBF.

© LFO SPEED (Vitesse de I'OBF)
Cliquez sur la zone de texte « SPEED » pour régler la vitesse.

© KEY SYNC (Synchronisation des touches)
Cliquez sur « KEY SYNC » pour activer/désactiver la synchronisation des touches de I'OBF.
(Si ce parametre est activé, la forme d'onde de I'OBF est relancée a chaque note jouée.)

O KEY ON DELAY (Retard de I'activation de touche)
Détermine le temps (retard) entre le moment ou un message d’activation de note est recu et
celui ou I'OBF entre en jeu.

© Bouton LFO PITCH (Hauteur de ton de I'OBF)
Ce bouton vous permet de régler la profondeur de modulation de ton de I'OBF. Vous pouvez
également saisir une valeur directement dans la zone de texte située a gauche du bouton.

O Bouton LFO FILTER (Filtre de I'OBF)
Ce bouton vous permet de régler la profondeur de modulation du filtre de I'OBF. Vous pouvez
également saisir une valeur directement dans la zone de texte située a gauche du bouton.

© Bouton LFO AMPLITUDE (Amplitude de I'OBF)
Ce bouton vous permet de régler la profondeur de modulation de I'amplitude de I'OBF. Vous
pouvez également saisir une valeur directement dans la zone de texte située a gauche du
bouton.
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© Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boite de dialogue « EL DETAIL » (Détail des éléments) et
saisir les parameétres de chaque élément. Le contrble des parametres est plus grand et plus
précis qu'avec les graphiques de I'éditeur.

Graphiques de I'éditeur

En cliquant sur les « poignées » (repéres carrés) de ces graphiques et en les faisant glisser,
VOus pouvez ajuster visuellement les paramétres de chacun des éléments.

BITIA 1l arrive que les poignées ne soient pas toutes visibles parce qu'elles sont superposées au méme endroit.
Si c'est le cas, cliquez sur la poignée visible et faites-la glisser temporairement afin de voir la poignée
suivante.

OSCILLATOR FILTER Lrriz

WAYE

WEL
LIMIT

MOTE LIMIT
—

PITCH EG FILTER EG AMPLITUDE EG

Réglages OSCILLATOR (Oscillateur)

Cliquez sur la zone de texte « WAVE » et sélectionnez la forme d'onde source. L'un des reperes
carrés sert a régler les parametres « VEL LIMIT LOW » (Limite de vélocité inférieure) et « NOTE
LIMIT LOW » (Limite de note inférieure). Réglez la vitesse de la note la plus basse en déplacant
la poignée horizontalement. Réglez la note la plus basse de la gamme en la déplacant
verticalement. De la méme fagon, réglez la vélocité de la note la plus haute (« VEL LIMIT HIGH »)
et la note la plus haute de la plage (« NOTE LIMIT HIGH ») a I'aide de I'autre poignée.

BITId Lorsque vous déplacez les poignées, des valeurs sont affectées sous la forme de coordonnées (X,Y), ot X
correspond a NOTE LIMIT (Limite de note) (donnée sous la forme d'un numéro de note MIDI) et Y a VEL
LIMIT (Limite de vélocité). Pour afficher le nom de la note au lieu de son numéro, sélectionnez I'onglet
« OSCILLATOR » de la boite de dialogue « EL DETAIL ».



Réglages FILTER (Filtre)

Cliquez sur la zone de texte et sélectionnez le type de filtre. Le graphique affiche des réglages
préprogrammeés, mais vous pouvez les modifier. Par exemple, si vous prenez le type LPF,
déplacez la poignée gauche verticalement pour régler le paramétre « Filter Gain » (Gain de
filtre). Faites glisser la poignée droite horizontalement pour régler la fréquence de coupure du
filtre.

BITi Les valeurs des parameétres s'affichent au fur et a mesure que vous déplacez les poignées. Pour régler
ces valeurs directement, sélectionnez I'onglet « FILTER EG » de la boite de dialogue « EL DETAIL ».

Réglages EQ

Cliquez sur la zone de texte et sélectionnez le type d'égaliseur. Par exemple, si vous prenez le
type EQ/LH, la poignée de gauche permet de contrbler les fréquences des basses et la poignée
de droite les fréquences des aigués. Déplacez les poignées verticalement pour régler le gain et
horizontalement pour ajuster la fréquence.

BITid Pour régler ces valeurs directement, sélectionnez I'onglet « OSCILLATOR » de la boite de dialogue « EL
DETAIL ».

Réglages PITCH EG (Générateur d'enveloppe de hauteur)

Le PITCH EG (Envelope Generator) détermine la transition de la hauteur de ton tandis que la
touche est maintenue enfoncée. Il y a cing poignées, chacune contrélant un stade différent de
I'enveloppe.

La premiéere poignée (la plus a gauche) contréle le parametre « Hold Time/Level » (Temps/niveau
de maintien), la deuxieme le parametre « Attack Time/Level » (Temps/niveau d'attaque), la
troisieme le parametre « Decay 1 Time/Level » (Temps/niveau de chute 1), la quatrieme le
paramétre « Decay 2 Time/Sustain Level » (Temps de chute 2/Niveau de maintien) et la derniére
(la plus a droite) le parameétre « Release Time/Level » (Temps/niveau de relachement). Déplacez
les poignées verticalement pour ajuster les niveaux et horizontalement pour régler les temps de
transition.

BITI Pour régler ces valeurs directement, sélectionnez I'onglet « PITCH » de la boite de dialogue « EL DETAIL ».

Réglages FILTER EG (Générateur d'enveloppe de filtre)

Le parametre FILTER EG (Envelope Generator) détermine la transition du timbre lorsque la
touche est maintenue enfoncée. Il 'y a cing poignées, chacune contrélant un stade différent de
I'enveloppe. La premiére poignée (la plus a gauche) contréle le paramétre « Hold Time/Level »,
la deuxieme le parametre « Attack Time/Level », la troisieme le parametre « Decay 1 Time/
Level », la quatrieme le paramétre « Decay 2 Time/Sustain Level » et la derniere (la plus a droite)
le parameétre « Release Time/Level ». Déplacez les poignées verticalement pour ajuster les
niveaux et horizontalement pour régler les temps de transition.

BIT1E Pour régler ces valeurs directement, sélectionnez I'onglet « FILTER EG » de la boite de dialogue « EL
DETAIL ».

Réglages AMPLITUDE EG (Générateur d'enveloppe d'amplitude)

L'AMPLITUDE EG (Envelope Generator) détermine la transition de I'amplitude dans le temps. Il y
a cing poignées, chacune contrélant un stade différent de I'enveloppe. La premiere poignée (a
I'extréme gauche) contrble le paramétre « Init Level » (Niveau initial), la deuxieme le parametre
« EG Attack Time » (Temps d'attaque de I'EG), la troisieme le parametre « EG Decay 1 Time/
Level » (Temps/niveau de chute 1 de I'EG), la quatrieme le parametre « Decay 2 Time/Sustain
Level » et la derniére (la plus a droite) le paramétre « EG Release Time » (Temps de relachement
de I'EG). Déplacez les poignées verticalement pour ajuster les niveaux et horizontalement pour
régler les temps de transition.

BITid Pour régler ces valeurs directement, sélectionnez I'onglet « AMP EG » de la boite de dialogue « EL

DETAIL ».



Boite de dialogue « DRUM KEY »
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W Note.....oovvoe, Affiche le nom de la note a éditer.
(2 Clavier........................... Cliguez sur le clavier pour affecter une note a I'élément ou a la

voix en cours d'édition. La zone de texte a gauche affiche le
nom de la note.

B TYPE..........ccooooii, Détermine la banque a laquelle appartient la source sonore :
Preset Wave (Onde préprogrammée) ou Voice (Voix).
(4) WAVE (Onde) ................... Pour sélectionner une forme d'onde comme source, cliquez

sur ce bouton, puis dans la zone de texte adjacente ou vous
pouvez la choisir.

(5) VOICE (VOIX) .................... Pour sélectionner une voix comme source, cliquez d'abord sur
ce bouton, puis dans la zone de texte adjacente pour ouvrir la
boite de dialogue « Voice List » (Liste de voix).

(6) COARSE (Brut)................ Utilisez ce bouton pour régler la hauteur de ton de I'élément
par demi-tons.

() VELOCITY (Vélocité)....... Utilisez ce bouton pour définir la variation du ton en fonction de
la vélocité de la note.

FINE (Fin)......................... Utilisez ce bouton pour la régler avec encore plus de précision.

(9) CUTOFF (Coupure) ......... Utilisez ce bouton pour régler la fréquence de coupure du filtre
passe-bas.

VELOCITY ..., Utilisez ce bouton pour régler I'ouverture et la fermeture du
filtre de I'élément par rapport a la vélocité de la note.

@) RESO (Résonance) ......... Utilisez ce bouton pour régler le niveau de résonance du filtre
passe-bas.

12 HPF (Filtre passe-haut)... Utilisez ce bouton pour régler la fréquence du filtre passe-haut.
13 AMPLITUDE VELOCITY .. Utilisez ce bouton pour définir la variation du niveau de sortie
(Vélocité de I'amplitude) de I'élément en fonction de la vélocité de la note.

RECEIVE NOTE ............... Cliquez sur la zone de texte pour choisir de recevoir ou non
(Réception de notes) des notes.
@ KEY ASSIGN.................. Cliquez sur la zone de texte pour choisir entre I'affectation

(Affectation de touches).d'une touche unique ou de plusieurs touches.
ALTERNATE GROUP....... Cliquez sur la zone de texte pour sélectionner un autre numéro

(Groupe alternatif) de groupe. Vous pouvez ainsi empécher des sons de batterie
couplés de se reproduire en méme temps (par exemple, une
cymbale ouverte et fermée).

©




@FILTER .................. Faites glisser une des poignées horizontalement pour régler le
parametre « HPF Cutoff Frequency » (Fréquence de coupure du filtre
passe-haut) de I'élément. Faites glisser I'autre poignée verticalement
pour régler le parametre « LPF Resonance » (Résonance du filtre
passe-bas) et horizontalement pour régler le parametre « LPF Cutoff
Frequency » (Fréquence de coupure du filtre passe-bas).

BT Pour régler ces valeurs directement, sélectionnez I'onglet « OSCILLATOR » de la boite de dialogue
DRUM KEY DETAIL.

AMPLITUDE EG .....Faites glisser la premiere poignée (la plus a gauche) horizontalement
pour ajuster le parametre « Attack Time » de I'élément. Faites glisser
la deuxiéme horizontalement pour régler le paramétre « Decay 1
Time » et horizontalement pour régler « Decay 1 Level ». Faites
glisser la derniere (la plus a droite) horizontalement pour ajuster le
parametre « Decay 2 Time ».

BITLd Pour régler ces valeurs directement, sélectionnez I'onglet « PARAMETER » de la boite de dialogue
DRUM KEY DETAIL.

EQ.............o Cliquez sur la zone de texte pour sélectionner le type d'EQ. Avec les
types « EQ L/H » et « PEQ », vous pouvez ajuster certains
parametres EQ a I'aide des poignées présentes dans les graphiques.
Déplacez I'une des poignées horizontalement pour régler le
parametre « EQ Low Frequency » (Fréquence des basses de
I'égaliseur) de I'élément et verticalement pour le paramétre « EQ Low
Gain » (Gain des basses fréquences de |'égaliseur). Faites glisser
I'autre poignée horizontalement pour ajuster le parametre « EQ High
Frequency » (Fréquence des aigués de |'égalisateur) de I'élément (ou
« EQ Resonance » si vous avez sélectionné le type P.EQ) et
verticalement pour régler le parametre « EQ High Gain » (Gain des
hautes fréquences de I'égaliseur).

BITiE Pour régler ces valeurs directement, sélectionnez I'onglet « OSCILLATOR » de la boite de dialogue
DRUM KEY DETAIL.

@ LEVEL ...................... Ce bouton vous permet de régler le niveau de I'élément.

@ PAN.................c.coo. Ce bouton vous permet de régler la position stéréo de I'élément.

@ RNDM PAN ................ Utilisez ce bouton pour régler la profondeur du balayage aléatoire
(Balayage aléatoire) de I'élément.

@) ALTER PAN

(Balayage alternatif).. Utilisez ce bouton pour régler la profondeur du balayage alternatif.
@ Sélecteur de I'affectation

de la sortie................ Cliquez sur la zone de texte pour sélectionner les sorties vers
lesquelles vous voulez envoyer |'élément.
@ EF1/EF2/THRU........... Cliquez sur le sélecteur [EF 1] pour transférer le signal via I'effet

d'insertion 1, sur [EF 2] pour le transmettre via I'effet d'insertion 2 et
sur [THRU] pour ignorer les effets d'insertion.

@ REVERB .................. Utilisez ce bouton pour régler le niveau du signal des effets

(Réverbération) d'insertion 1/2 (ou le signal ignoré) envoyé a la section de

réverbération.

@ CHORUS (Cheeur) ..... Utilisez ce bouton pour régler le niveau du signal des effets
d'insertion 1/2 (ou le signal ignoré) envoyé a la section CHORUS.

DETAIL ..................... Cliquez sur ce bouton pour ouvrir la boite de dialogue « DRUM
KEY DETAIL » et saisir directement des valeurs pour tous les
éléments (a I'exception de I'affectation des notes du clavier).

BITid Le signal émis par I'EQ est envoyé vers le paramétre LEVEL situé dans le coin inférieur gauche de
la boite de dialogue Drum Key.

B3 Lorsque le parametre OSCILLATOR TYPE est réglé sur « Voice », les paramétres 7, 9 -14, 16 -19,
22 et 23 décrits ci-dessus ne sont pas disponibles.
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© Sélecteur CONNECT (Connexion)
Cliguez sur la zone de texte et sélectionnez I'ordre dans lequel les signaux sont transmis
d'une section d'effet d'insertion a l'autre.

© Témoins lumineux
Ces témoins vous indiquent quels éléments sont affectés aux différentes sections d'effets
d'insertion. lls ne sont pas disponibles pour les voix de batterie.

© Bouton [DETAIL]
Cliquez sur ce bouton pour ouvrir la boite de dialogue Insertion Effect et régler les parametres
détaillés.

O Sélecteur du type d'effet
Cliguez sur la zone de texte et sélectionnez le type d'effet d'insertion.

Section Insertion Effect 2
Identique a la section Insertion Effect 1. Voir ci-dessus.

Effets systéme

@® Section Reverb
7

2

L2020

P |

© Reverb Send (Envoi de réverbération)
Ce bouton vous permet de régler le niveau du signal de I'effet d'insertion 1/2 (ou du signall
ignoré) envoyé a l'effet de réverbération.

@ Sélecteur du type d'effet de réverbération
Cliquez sur la zone de texte et sélectionnez le type d'effet de réverbération.

©



© Commandes Reverb Pan (Panoramique de réverbération)
Utilisez ces boutons pour régler la position stéréo de I'effet de réverbération.

O Commandes Reverb Return (Retour de réverbération)
Ces boutons vous permettent de régler le volume de chacun des effets de réverbération
utilisés dans le signal de sortie.

© Bouton [DETAIL]

Cliquez sur ce bouton pour ouvrir la boite de dialogue Reverb et régler les parameétres
détaillés.

@® Section Chorus

© Chorus Send (Envoi vers le checeur)
Ce bouton vous permet de régler le niveau du signal de I'effet d'insertion 1/2 (ou du signal
ignoré) envoyé a l'effet de cheeur.

@ Sélecteur du type d'effet de choeur
Cliguez sur la zone de texte et sélectionnez le type d'effet de choeur.

©® Commande Chorus Pan (Panoramique de checeur)
Utilisez ce bouton pour régler la position stéréo de I'effet de choeur.

O Commande Chorus Return (Retour de choeur)
Utilisez ce bouton pour régler le volume de chaque effet de choeur utilisé dans le signal de
sortie.

© Bouton [DETAIL]
Cliguez sur ce bouton pour ouvrir la boite de dialogue Chorus et régler les parameétres
détaillés.

© Commande CHORUS REVERB (Chceur vers réverbération)
Ce bouton vous permet de régler le niveau du signal envoyé depuis I'effet de choeur vers
I'effet de réverbération.



Barre d'outils

© Bouton « Editor Setup »
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Setup ». Voir page 12 pour plus de
détails.

© Bouton « Library Window »
Cliquez sur ce bouton pour faire réapparaitre la fenétre Library au premier plan. Voir page 8
pour plus de détails.

©® Bouton « Store » (Stocker)
Cliquez sur ce bouton pour ouvrir la boite de dialogue « Store ». Voir ci-dessous pour plus de
détails.

Boite de dialogue « Store »

Vous pouvez stocker la voix éditée dans n'importe quel fichier Bibliotheque.

Store Dialog E

Woice MWame IBriteS?DD

Mermary : IUser Mormall j
Mo | Yaice MName ﬂ
e
o0z Old Blues

003 | 5700&0IdER
004 | S700&DE

ans Eell Fiano
00& Drzam
ooz Tomorow

nog FianokPad
003 CPa0sERP
oo Yama EP's

01 Mr. Klank &
4| | B

Stare | Cancel |

1 Cliquez sur la case Voice Name (Nom de voix) en haut de la boite de dialogue. Le curseur
apparait en surbrillance et vous pouvez alors saisir le nom.

2 Saisissez le nom de la voix via le clavier de I'ordinateur.

BT Les noms de voix peuvent comporter jusqu'a 10 caractéres.

3 Cliquez sur la case Memory et choisissez la mémoire dans laquelle vous souhaitez

stocker la voix éditée.




4 Dans la liste Voice Name, cliquez sur la voix dans laquelle vous voulez stocker la voix
éditée.

&ATTENTION

Une fois les nouvelles données stockées dans un fichier Bibliotheque, les données de la voix d'origine
sont écrasées au moment ou vous sauvegardez ce fichier. Il est dés lors recommandé d'effectuer des
copies de sauvegarde de toutes les données importantes.

5 Cliquez sur le bouton [Store] pour stocker la voix éditée & I'emplacement spécifié a
I'étape 4.

AATTENTION

La bolte de dialogue « Store » est utilisée pour stocker temporairement votre fichier Bibliotheque. Aprés
I'avoir stocké, vous devez I'enregistrer. Si vous ne le faites pas, les modifications apportées au fichier ne
seront pas sauvegardées.

O Bouton « Compare » (Comparer)
Lorsque vous cliquez sur ce bouton, des blocs de données de la voix d'origine (avant édition)
sont envoyés au générateur de sons. Cliquez de nouveau dessus pour envoyer les blocs de
données de la voix éditée. Ce bouton permet alors d'effectuer des comparaisons A/B entre la

voix d'origine et la voix éditée.

Exemple d'utilisation du Voice Editor

Il n'existe pas une fagon unique d'utiliser les nombreux composants du Voice Editor. Vos besoins
et préférences en matiere d'édition peuvent différer. L'exemple suivant est toutefois un guide
pas-a-pas simple sur la maniere d'utiliser le Voice Editor.

La fenétre Library étant la premiere a s'ouvrir, c'est la que commencent les explications.

BITid Dans la fenétre Library, vous pouvez ouvrir des fichiers Bibliothéque existants contenant les voix que vous
souhaitez éditer, de méme que vous pouvez importer des voix spécifiques vers la fenétre Library.

1 Cliquez sur le bouton « Editor Setup » de la barre d'outils de la fenétre Library pour ouvrir la
boite de dialogue « Setup ». Sélectionnez ensuite les paramétres MIDI In/Out Port et Device
No. adaptés a votre générateur de sons (reportez-vous a la section Boite de dialogue
« Setup »).

P Sivous utilisez un Macintosh, vous devez également régler les paramétres de I'OMS (page 33).

BITid Sivous utilisez Windows, vous devez également effectuer des réglages dans la barre d'outils MIDI
Setup ou dans le port MIDI de I'application hote.

2 Recevez les données de voix utilisateur en provenance de votre générateur de sons.

(1) Sélectionnez [Receive Bulk...(Receive...)] (page 7) dans le menu [Setup (MID)].

(2) Sélectionnez « All » (Tous) dans « Receive Type », puis cliquez sur le bouton [Start]
(page 14). Fermez la boite de dialogue apres réception. La voix regue apparait alors.

3 Dans la liste de voix de la fenétre Library, double-cliquez sur la voix que vous souhaitez
modifier. La fenétre Edit correspondant a cette voix s'ouvre.

@



4 Plusieurs blocs sont arrangés dans la fenétre Edit. Commencez par régler les parametres des
éléments 1 a 4 du bloc Element qui constituent la voix. Ouvrez les boites de dialogue des
éléments 1 a 4, sélectionnez les formes d'onde et ajustez les caractéristiques sonores de la
voix a l'aide des filtres et des égaliseurs. Vous pouvez utiliser les éditeurs graphiques
présents dans les différentes boites de dialogue pour modifier visuellement les paramétres.

P Vous pouvez modifier les paramétres des éléments avec beaucoup plus de précision dans les boites
de dialogue « EL DETAIL ». Les boites de dialogue des éléments sont associées aux boites de
dialogue « EL DETAIL », de sorte que toutes les modifications apportées dans les unes sont
immédiatement répercutées dans les autres. Vous pouvez afficher simultanément les graphiques et les
boltes de dialogue « EL DETAIL » cote a cote pendant I'édition.

PIT1d De plus, dans la section Element, vous pouvez régler le niveau de sortie de chaque élément et
I'associer aux effets d'insertion 1/2.

5 Sélectionnez le type d'effet d'insertion dans la section d'insertion 1/2 et réglez les paramétres
restants.

6 Sélectionnez le type d'effet systéme dans la section Reverb/Chorus et réglez les parametres
restants.

7 Sinécessaire, réglez les paramétres Arpeggio et Portamento.

8 Cliguez sur le bouton « Store » de la barre d'outils de la fenétre Edit pour ouvrir la boite de
dialogue « Store », qui vous permet de stocker les modifications de la voix actuellement
sélectionnée dans le fichier Bibliotheque.

Pl Les modifications apportées a la voix ne sont enregistrées dans le fichier Bibliothéque que de fagon
temporaire. N'oubliez pas que si vous poursuivez sans enregistrer le fichier Bibliotheque, vous perdrez
toutes les modifications apportées.

9 Revenez dans la fenétre Library et cliquez sur le bouton « Save » de la barre d'outils pour
enregistrer (écraser) le fichier Bibliotheque. Les modifications apportées a la voix, ainsi que la
voix elle-méme, sont enregistrées a I'endroit indiqué de la liste de voix.

BITid Vous pouvez ouvrir le fichier Bibliothéque que vous avez enregistré dans la fenétre Library a tout
moment. En outre, vous pouvez envoyer les voix de la fenétre Library a votre synthétiseur.

PBITd Vous pouvez créer de nombreux fichiers Bibliotheéque différents, taillés sur mesure pour des différents
types d'applications, telles que des performances live, des enregistrements, etc. Vous pouvez donc
modifier les voix a votre guise de maniere a ce qu'elles répondent a différents besoins ou situations.

10 Cliquez sur le bouton « Transmit » de la barre d'outils de la fenétre Library pour envoyer la
voix éditée de I'ordinateur vers le MOTIF-RACK. Une fois I'opération terminée, vous pouvez
sélectionner la voix éditée sur le panneau du MOTIF-RACK.



Réglages OMS (Macintosh)

Le logiciel Voice Editor utilise I'OMS (Open Music System (Systeme de musique ouvert)) pour les
entrées/sorties MIDI. Pour utiliser le logiciel Voice Editor, vous devez préalablement installer
I'OMS.

BITid Pour plus d'informations sur l'installation de I'OMS, reportez-vous au manuel d'installation fourni a part.

A propos de I'OMS

Le Voice Editor utilise I'OMS (Open Music System) pour transférer des données MIDI vers un
périphérique MIDI externe. OMS est une extension systeme localisée dans le dossier Mac OS
System qui est congue pour gérer le flux de données MIDI (entrée et sortie) dans un ordinateur
de maniere a permettre le transfert de données MIDI entre le logiciel et le matériel MIDI relié¢ a
l'ordinateur. OMS est un standard de facto dans I'environnement MIDI sous Mac OS. De
nombreux fabricants de logiciels de musique ont mis sur le marché un séquenceur et d'autres
logiciels compatibles avec OMS.

OMS présente les avantages suivants :

e Dans la mesure ou les applications MIDI compatibles OMS communiquent avec divers
appareils MIDI via I'OMS, il n'est plus nécessaire d'installer plusieurs pilotes MIDI pour ces
applications. Vous évitez ainsi des conflits entre des pilotes différents jouant le méme réle
(contréle MIDI).

e Une fois que la configuration du studio est lue dans I'OMS, I'application compatible OMS la
détecte, méme si vous devez reconfigurer le routage du flux de données MIDI ou modifier la
configuration actuelle du studio. Les applications compatibles avec I'OMS reconnaissent
généralement la nouvelle configuration.

e \ous avez le choix entre différentes configurations de studio, qui vous permettent de basculer
instantanément vers un routage MIDI différent (connexions entre les périphériques et le
logiciel MIDI).

e (Chaque fois que vous ouvrez |'application de configuration OMS, tous les appareils MIDI
connectés a l'ordinateur sont automatiquement détectés. Une icbne apparait alors avec un
statut MIDI actuel (numéro de canal, numéro de port, connexions, etc.). Une fois que les
périphériques sont correctement configurés a l'aide de I'application OMS Setup, vous ne
devez plus vous préoccuper du statut.

e | 'OMS peut piloter plusieurs interfaces MIDI, y compris le type standard (16 canaux) et le
type a ports multiples (16 canaux par port). Si vous utilisez un type a ports multiples, vous
pouvez contrbler plus de 16 pistes simultanément via I'OMS.

BITId Pour plus d'informations sur les fonctions OMS, reportez-vous au fichier READ ME (Lisez-moi) fourni
avec I'OMS.



Configuration des ports OMS

Une fois que vous avez configuré I'OMS, vous devez lancer le Voice Editor et paramétrer les
ports OMS.

1 Lancez le Voice Editor en double-cliquant sur son icone.

BITIA Si AppleTalk est activé, un message d'avertissement apparait. Cliquez sur « OFF » (Désactiver). La
désactivation d'AppleTalk prend un certain temps.

2 Sélectionnez « OMS Port Setup » dans le menu « MIDI » du Voice Editor, puis sélectionnez les
réglages des ports.

Dans I'exemple suivant, le générateur de sons est un MOTIF-RACK et ses réglages sont
appliqgués a I'OMS.

OMS Port Setup

MIDI In: b4 Key Thru

| MOTIF-RACK 1 ~|
MIDI Qut:

| MOTIF-RACK1 ~ |

KeyThru................. Cochez cette case si vous contrdlez un module de générateur de sons a
l'aide d'un clavier externe.

MIDIIn: ................ Sélectionnez « MOTIF-RACK-1 ».

MIDIOut: ............. Sélectionnez « MOTIF-RACK-1 ».

3 Cliquez sur [OK] pour fermer la boite de dialogue OMS Port Setup.



Dépistage des pannes

Si vous rencontrez des problemes tels que I'absence de son ou un comportement anormal,
vérifiez les connexions avant de passer aux points suivants.

<Windows / Macintosh>
Le son ne change pas lorsque vous manipulez les boutons ou les curseurs.
e | e port de sortie MIDI et le numéro de I'appareil sont-ils correctement paramétrés dans la
boite de dialogue « Editor Setup » ? (pages 12, 34)

Les blocs de données ne sont pas transmis.
e | e port de sortie MIDI et le numéro de I'appareil sont-ils correctement paramétrés dans la
boite de dialogue « Editor Setup » ? (pages 12, 34)
¢ |'intervalle de vidage défini dans la boite de dialogue « Editor Setup » ne serait-il pas trop
court ? Assurez-vous que l'intervalle est d'au moins 20 ms.

Aucun son ne sort lorsque vous cliquez sur le clavier qui apparait a I'écran dans la fenétre
Edit.

e Le canal MIDI est-il correctement paramétré dans la boite de dialogue « Editor Setup » ?
(page 12)
Le son ne change pas lorsque vous appuyez sur le bouton Monitor.

e Le port MIDI Out et le numéro de I'appareil sont-ils correctement réglés dans la boite de
dialogue Editor Setup (OMS Port Setup) ? (pages 12, 34)

<Windows>
Les blocs de données ne sont pas recus.
e Quvrez la boite de dialogue Setup et vérifiez que le numéro de I'appareil est correctement
affecté (page 12).
e | e port MIDI Thru est-il désactivé dans l'application client ?

Le port MIDI In/Out n'est pas disponible dans la boite de dialogue Editor Setup.
e Le port MIDI In/Out de la boite de dialogue Editor Setup est sélectionné a partir des ports
MIDI In/Out de la boite de dialogue MIDI Setup. Vérifiez les réglages MIDI In/Out de la
barre d'outils MIDI Setup ou de I'application hote.

<Macintosh>
Le port USB n'est pas reconnu.

o Vérifiez si le pilote USB a été correctement installé sur votre ordinateur. Reportez-vous au
manuel d'installation pour plus de détails.

Le port du modem/de I'imprimante n'est pas reconnu.

e \Veérifiez la connexion et les réglages de l'interface MIDI.

e Sur certains modeles Macintosh comme ceux de la série Performa, il est impossible
d'utiliser le port du modem. Seul le port de I'imprimante est disponible.

e | e port du modem/de I'imprimante n'est pas reconnu lorsque AppleTalk est activé. Veuillez
noter que sur certains modeles Macintosh, AppleTalk est automatiquement activé au
démarrage.

e \Vérifiez que la case « Modem » ou « Printer » (Imprimante) a bien été cochée dans la
fenétre OMS MIDI Setup.

@



Pas de données MIDI In/Out

o Vérifiez si le réglage MIDI IN/OUT du mode Utility (Utilitaire) correspond au céble
réellement utilisé (USB ou MIDI).

e |es ports MIDI In/Out sont-ils configurés comme étant inconnus dans la fenétre OMS Port
Setup 7 Si vous modifiez les ports ou les paramétres de I'OMS, les ports de sortie de I'OMS
doivent étre configurés en conséquence dans la fenétre OMS Port Setup du Voice Editor.
Sélectionnez le périphérique de réception approprié.

e Sil'affectation des ports et des parametres est fréquemment modifiée, il est possible que
I'OMS éprouve des difficultés a reconnaitre le port. Redémarrez le Macintosh, configurez
I'OMS correctement, puis lancez le Voice Editor.

Les blocs de données ne sont pas recus.
e Quvrez la fenétre OMS Port Setup et vérifiez que le port MIDI In a été correctement
configuré (page 34).
e Quvrez la boite de dialogue Setup et vérifiez que le numéro de I'appareil est correctement
affecté (page 12).

Le Voice Editor ne démarre pas lorsque vous double-cliquez sur le fichier Bibliotheque
(extension .W6E).
e Modifiez les réglages Type/Creator (Créateur) des fichiers Bibliotheque comme suit, puis
essayez de nouveau de double-cliquer sur le fichier.
Type : W6E_
Creator : YMTR
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